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EMC Information

FEDERAL COMMUNICATIONS COMMISSION INTERFERENCE 
STATEMENT

This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the 
user will be required to correct the interference at his own expense.

FCC Caution: Any changes or modifications not expressly approved by the party 
responsible for compliance could void the user's authority to operate this equipment.

CE Warning: This is a class A product. In a domestic environment this product may 
cause radio interference in which case the user may be required to take adequate 
measures.

KCC Statement
유선 제품용 / A급 기기 (업무용 방송 통신 기기 ) 
이 기기는 업무용 (A급 ) 전자파적합기기로서 판매자 또는 사용자는 이
점을 주의하시기 바라며 , 가정 외의 지역에서 사용하는 것을 목적으로 
합니다 .

RoHS

This product is RoHS compliant.

Safety

This product has been classified as Information Technology Equipment.
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SJ/T 11364-2006

The following contains information that relates to China.
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User Information

Online Registration
Be sure to register your product at our online support center:

Telephone Support
For telephone support, call this number:

User Notice
All information, documentation, and specifications contained in this manual 
are subject to change without prior notification by the manufacturer. The 
manufacturer makes no representations or warranties, either expressed or 
implied, with respect to the contents hereof and specifically disclaims any 
warranties as to merchantability or fitness for any particular purpose. Any of 
the manufacturer's software described in this manual is sold or licensed as is. 
Should the programs prove defective following their purchase, the buyer (and 
not the manufacturer, its distributor, or its dealer), assumes the entire cost of all 
necessary servicing, repair and any incidental or consequential damages 
resulting from any defect in the software.

The manufacturer of this system is not responsible for any radio and/or TV 
interference caused by unauthorized modifications to this device. It is the 
responsibility of the user to correct such interference.

The manufacturer is not responsible for any damage incurred in the operation 
of this system if the correct operational voltage setting was not selected prior 
to operation. PLEASE VERIFY THAT THE VOLTAGE SETTING IS 
CORRECT BEFORE USE.

International http://eservice.aten.com 

International 886-2-8692-6959

China 86-10-5255-0110

Japan 81-3-5615-5811

Korea 82-2-467-6789

North America 1-888-999-ATEN ext 4988

United Kingdom 44-8-4481-58923
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Package Contents

The VK2100 package consists of:
1 VK2100 ATEN Controller
1 Rack Mount Kit
9 Terminal Blocks
1 Power Cord
1 Software CD
1 User Instructions*

Check to make sure that all the components are present and that nothing got 
damaged in shipping. If you encounter a problem, contact your dealer.

Read this manual thoroughly and follow the installation and operation 
procedures carefully to prevent any damage to the unit, and/or any of the 
devices connected to it.

* Features may have been added to the ATEN Control System since this 
manual was published Please visit our website to download the most up-to-
date version.

© Copyright 2015 ATEN® International Co., Ltd.
Manual Date: 2015-09-23

ATEN and the ATEN logo are registered trademarks of ATEN International Co., Ltd. All rights reserved. 
All other brand names and trademarks are the registered property of their respective owners.
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About this Manual

This User Manual is provided to help you get the most from your ATEN 
Control System. It covers all aspects of installation, configuration and 
operation. An overview of the information found in the manual is provided 
below.

Chapter 1, Introduction, introduces you to the ATEN Control System. Its 
purpose, features and benefits are presented, and the VK2100’s front and back 
panel components are described.

Chapter 2, Hardware Setup, provides the necessary steps to setup the 
VK2100 installation, including how to wire the different types of hardware 
connections.

Chapter 3, Browser Operation, provides a complete description of the 
VK2100's Browser Graphical User Interface (GUI) and how to use it to 
remotely configure parts of the VK2100 installation.

Chapter 4, Software Installation, explains the steps required to download 
and install the VK6000 software.

Chapter 5, ATEN Configurator (VK6000), provides a complete 
description of the VK6000 software and how to use it to configure and operate 
the VK2100.

Chapter 6, ATEN Database Generator, provides a complete description 
of the Database Generator software and how to use it to configure new devices 
to add to the VK6000 device library.

Chapter 7, ATEN Control System App, provides a complete description 
of the iPad app and how to use it to operate devices connected to the VK2100.

An Appendix, provides specifications and other technical information 
regarding the VK2100.
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Conventions

This manual uses the following conventions:

Product Information

For information about all ATEN products and how they can help you connect 
without limits, visit ATEN on the Web or contact an ATEN Authorized 
Reseller. Visit ATEN on the Web for a list of locations and telephone numbers:

Monospaced Indicates text that you should key in.

[ ] Indicates keys you should press. For example, [Enter] means to 
press the Enter key. If keys need to be chorded, they appear 
together in the same bracket with a plus sign between them: 
[Ctrl+Alt].

1. Numbered lists represent procedures with sequential steps.

♦ Bullet lists provide information, but do not involve sequential steps.

→ Indicates selecting the option (on a menu or dialog box, for 
example), that comes next. For example, Start → Run means to 
open the Start menu, and then select Run.

Indicates critical information.

International http://www.aten.com

North America http://www.aten-usa.com
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Chapter 1
Introduction

Overview

The ATEN Control System, incorporating the VK2100 (ATEN Controller), the 
VK6000 (ATEN Configurator) and the ATEN Control System App is a 
standard Ethernet-based management system that connects all hardware 
devices in a room or large facility to provide centralized control of devices 
directly and effortlessly via an iPad. The VK2100 works as the main controller 
that provides great connectivity to all sorts of hardware devices commonly 
seen in a room. After connecting the hardware, the VK6000 software allows 
customizable device configuration via creation of a simple system project in 4 
easy steps. By connecting to the VK2100 via Ethernet, the ATEN Control 
System App empowers you with the mobility to control different hardware 
devices in different rooms whenever and however you like.

The VK2100 can easily deploy into an existing installation and integrate 
seamlessly with ATEN VanCryst pro-A/V products and a complete line of 
hardware devices, including A/V equipment, lighting systems, air 
conditioning, motion sensors, power switches and much more. The VK2100 
serves as a centralized platform where hardware devices are converged to be 
monitored, managed and controlled directly via a tailor-made GUI from an 
iPad.

The VK6000 features a quick setup that facilitates the configuration of 
hardware control and device operations in 4 easy steps via an intuitive GUI. 
Through an Ethernet connection, the ATEN Control System App enables you 
to import and update viewer profiles from the VK2100 via a point-n-tap user 
interface. Each viewer profile provides a customized control GUI that grants 
you quick access to target hardware devices. Use of any profile is protected 
with password authentication to secure system access.

The ATEN Control System is perfectly applicable in meeting rooms, 
conference centers, boardrooms, classrooms or any room that requires 
collaboration of a variety of hardware devices through a streamlined 
management tool with optimum efficiency and performance.
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Expandable and Manageable Device Library
The ATEN Library is comprised of 10,000+ device drivers along with the 
complete line of ATEN VanCryst product drivers. This extensive portfolio of 
driver resources is built into the system upon the VK6000 installation which 
makes hardware installation as easy as plug-n-play. This device database can 
be expanded by adding new devices to the Database Generator which comes in 
handy when the system fails to locate a specific driver from the ATEN Library. 
Furthermore, device management is simplified and centralized using My 
Library which consolidates device information in an organized list for faster 
hardware setup in projects. This expandable and manageable device database 
is beneficial and time-efficient as the scope and size of installations grow.

Simplified Setup via Intuitive GUI 
The ATEN Configurator (VK6000 software) offers an intuitive and 
streamlined GUI to simplify a complicated hardware setup process in 4 easy 
steps: create project > select device > configure viewer profile > upload profile. 
Operations for any room can be customized in a profile that includes a 
programmable GUI designed for each iPad model’s screen size, meaning 
“what you see is what you get”. Furthermore, actions and commands that 
correspond to the control buttons and icons added to the GUI will also be 
included. All control buttons can then be examined beforehand via Simulator 
and a test tool to verify how each configuration will respond and appear on the 
iPad, allowing you to avoid the need for re-configuration after the profile has 
been imported to the iPad for use. This straightforward and streamlined GUI is 
helpful in boosting the speed of system setup by cutting out repetitive checks, 
thereby allowing system administrators to quickly become acclimated with 
device management.

Facilitation with Multiple Controller/Profile/iPad Control
While plotting your installation, system control can start with one room and 
scale up to multiple rooms in the same area or across regions. From an iPad, 
toggling between profiles imported from the controller (VK2100) facilitates 
system control of different rooms with simple point-n-tap operations. 
Meanwhile, multiple iPads can be authorized with control over the same room 
simultaneously, depending on your software license. On the other hand, user 
access to any profile on the iPad can be restricted with password authentication 
to enhance system security. This versatile system framework is beneficial as 
system control can respond promptly and flexibly to any changes made, 
without suffering from unexpected service interruptions.
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Features

VK2100 (Hardware Controller)
Supports various connection interfaces, including:

6 x Serial port
4 x IR/Serial port
4 x Relay channel
4 x I/O channel
1 x Ethernet port

4 x DC output for power supply connections
1 x USB port for easy profile upload
IR Learning function for adding IR device drivers
Easy system settings via the web GUI
LED indication for hardware status and active messages
Rack-mountable

VK6000 (Configurator Software)
Simple profile setup in 4 easy configuration steps via intuitive GUI
Customizable GUI design and control operations for the iPad
Built-in Database Generator for device driver setup and overall device 
management
Built-in ATEN Library comprising 10,000+ device drivers and complete 
ATEN VanCryst product drivers
Test tool to verify commands in action before uploading the profile to the 
VK2100
Simulator to try out and review the customized GUI before uploading the 
profile to the VK2100
SSH tool to monitor the input and output signals of the controller

ATEN Control System App
Controls multiple rooms via multiple profiles imported from the 
VK2100(s)
Restricted user access to profiles via password authentication
Synchronization of system controls amongst multiple iPads
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Requirements

The following equipment is required for a installation:

Hardware Devices
A device for each type of hardware connection that will be wired to the 
VK2100, which can include: 

Bi-directional RS-232/422/485 serial devices
One-way IR or serial transmitter hardware devices
Relay hardware devices
Digital input hardware devices
Digital output hardware devices
Ethernet controlled PJLink and Telnet devices

Cables
Cat 5e/6 Ethernet cable used to connect the VK2100 to the local area 
network
For serial devices with DB9 connectors use standard straight through 
cables.

Computer & Software
PC installed with the ATEN Configurator software (VK6000) 
iPad installed with the ATEN Control System App

Operating Systems
Supported operating systems for the ATEN Configurator software (VK6000) 
are shown in the table, below:

OS Version

Windows XP, 7, 8, 8.1 and higher
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Components

Front View

No. Component Description

1 Relay LED The LED lights green to indicate an active device 
connection (closed loop).

2 IR/Serial LED The LED lights green to indicate an active device 
connection and IR/Serial signals are being transmitted.

3 I/O LED The LED lights green to indicate an active device 
connection and I/O signals are being transmitted.

4 Serial LED The LED (1~6) lights green to indicate serial signals 
are being transmitted.

5 Ethernet LED The LEDs provide information about the network 
connection:

Link: The LED blinks green to indicate Ethernet sig-
nals are being transmitted.
ACT: The LED lights green to indicate 100Mbps 
transmissions.

6 DC Overload LED The LED lights orange to indicate DC output exceeds 
maximum output.
Note: When the LED lights orange, please unplug any 
of the connected devices to keep its total output under 
24W.

7 IR Receiver / LED This IR receiver passes the functions of a remote 
control to the VK2100 in learning mode. The distance 
between the IR remote and the receiver window 
should be kept under 10cm with a direct line of sight.

The LED blinks green to indicate the unit is ready to 
receive signals from an IR remote control.

1 1052 43 6 7 8 9
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8 USB Port / LED This is where a USB device plugs in to upload Viewer 
files to the VK2100.

The LED blinks green to indicate Viewer files are 
being uploaded, and lights green to indicate a 
successful upload of Viewer files.

The LED lights orange to indicate Viewer files failed 
to upload.

9 Reset This semi-recessed pushbutton can be pressed to 
reset the VK2100’s network settings.

10 Power LED Lights green when the unit is turned on. 

No. Component Description
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Rear View

No. Component Description

1 Grounding Terminal The grounding wire attaches here.

2 Power Socket This is a standard 3-pin AC power socket. The power 
cord from an AC source plugs in here.

3 Power Switch This is a standard rocker switch that powers the unit 
on and off.

4 DC Output Ports Four outputs provide a total power output of 24W /2A 
max.

5 Relay Channels Four channels; normally open, isolated relays with a 
contact rating of 24VDC, 2A max.

6 IR / Serial Ports Four IR ports that can also be configured as RS-232 
TX ports. pin1: Signal / pin2: Ground. 

7 I/O Channels Four channels that can be configured as digital input 
or digital output ports. 

Digital Input: 0-24VDC programmable input range or 
contact closure with +12VDC pull-up

Digital Output: 250mA sink from 12VDC
Pin1~4: Signal / Pin5: Ground

8 RS-232 Ports Two RS-232 ports with TX/RX functions supported.

9 RS-232/422/485 Ports Four ports with supported RS-232/422/485 conversion 
by pin assignment and RTS/CTS flow control. The 
RS232, RS422, or RS485 connection is defined by 
pin. For pin assignments, see page 23.

10 Ethernet Port This RJ-45 port is used for the network connection. If 
no IP address is assigned within 30 seconds, the 
default IP settings will be used:
IP: 192.168.0.60 / mask: 255.255.255.0

11 Controller ID Switch This 16-segment switch is used for controller ID 
selection.

1 2 3 4 5 6 87 119 10
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Chapter 2
Hardware Setup

Rack Mounting

The VK2100 can be mounted in a 19” (1U) system rack. To install the device 
in a rack, do the following: 

1. Use the M3 x 8 Phillips head hex screws supplied with the Rack Mount 
Kit to screw the rack mounting brackets onto the front of the unit.

(Continues on next page.)

1. Important safety information regarding the placement of this 
device is provided on page 111. Please review it before 
proceeding.

2. Make sure that the power to all devices connected to the 
installation are turned off. You must unplug the power cords of 
any computers that have the Keyboard Power On function.
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2. Position the unit in the front of the rack and align the holes in the mounting 
brackets with the holes in the rack.

3. Screw the mounting brackets to the rack.
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Connections

Installation of the VK2100 is a matter of connecting the appropriate wires. 
Refer to the installation diagrams on the pages that follow to setup each device 
and use the instructions below as a guide (each step provides a corresponding 
page with diagram), and do the following:

Connect the hardware devices to the VK2100 using these instructions:

1. Use the DC Output terminals to wire 12VDC power connections using the 
instructions on page 13.

2. Use the Relay terminals to wire relay device connections using the 
instructions on page 17.

3. Use the IR/Serial (TX) terminals to wire IR or serial device connections 
using the instructions on page 18.

4. Use the Digital I/O terminals to wire digital Input/Output device 
connections using the instructions on page 20.

5. Use the RS-232 terminals to wire RS-232 serial device connections using 
the instructions on page 22.

6. Use the DB-9 ports to wire RS-232/422/485 serial device connections 
using the instructions on page 23.

7. Use a grounding wire to ground the unit by connecting one end of the wire 
to the grounding terminal, and the other end of the wire to a suitable 
grounded object.

Note: Do not omit this step. Proper grounding helps to prevent damage to 
the unit from surges or static electricity.

8. Use an Cat 5e/6 cable to connect the VK2100’s Ethernet port to the 
network.

9. Set the Controller ID to the appropriate setting for this unit. 

10. Plug the power cord supplied with the package into the VK2100’s 3-prong 
AC socket and then into an AC power source. 
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Installation Diagram
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12VDC Power Output
Four ports provide 12VDC of power with a total of 24 watts. The output can 
power four independent hardware devices, four loops for connected relay 
devices, or four digital output devices as shown in the diagrams on the next 3 
pages. If the combined current of the ports exceeds 2A, the DC Power 
Overload LED lights orange and the ports are turned off. The power will return 
to the four ports when the total current drops below 2A. After the overload 
resets it may take up to 30 seconds for power to return to the ports. 

Independent Power Supply

 
Power Supply: 12VDC, 2A Max 

(24W shared by 4 ports)

Provides 12VDC power to 
independent hardware devices.

Connects to

4 x 12VDC Output Ports
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Relay Power Supply

Connects to

Provides 12VDC power 
for the relay loop.

 
Power Supply: 12VDC, 2A Max 

(24W shared by 4 ports)

4 x 12VDC Output Ports

Switch, Screen, Projector Lift, 
Lighting, Motorized Equipment, 

Motion Device, etc.
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Digital Output Power Supply

Power Supply: 12VDC, 2A Max 
(24W shared by 4 ports)

Connects to
Switch, Screen, Projector Lift, 

Lighting and Equipment Control.

4 x 12VDC Output Ports

Provides 12VDC power
for the digital output loop.
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Digital Output Dual Power Supply

Power Supply: 12VDC, 2A Max 
(24W shared by 4 ports)

4 x 12VDC Output Ports

Provides 12VDC power 
for the digital output loop.

Provides connection to 
digital output #2.

Provides connection to 
digital output #1.
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Relay
These four Relay channels provide connections to control hardware devices 
such as electric screens, projector lifts and other motorized equipment. Each 
relay is normally open by default. 

Normally
Open Closed

 
Normally Open, Isolated Relays
Contact Rating: 24VDC 2A Max

Switch, Screen, Projector Lift, 
Lighting, Motorized Equipment, 

Motion Device, etc.

Connects to

4 x Relay Channels
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IR / Serial
These four ports can be configured to connect IR and RS-232 devices. By 
default the ports are set to transmit IR signals. Use the ATEN Configurator 
software to configure the ports for RS-232 signals. 

IR Connection: Connect a transmitter cable to the IR and Ground ports on the 
VK2100 and install the IR transmitter on or near the device's IR receiving port, 
as shown on page 19.

Serial Connection: Connect the device's receiver (RX) and ground ports to the 
Serial (TX) and Ground ports on the VK2100. Next configure the same serial 
port setting on the VK2100 and serial device so that they can communicate. 

Uni-directional (+ -5 V) 

Baud Rate: 300 to 115200 
(default: 9600)

Data Bit: 8 (default) or 7

Stop Bit: 1 (default) or 2

Parity: None (default), Even or 
Odd

IR: Blu-ray / DVD Player, TV, 
Audio Receiver, Projector, etc.

RS-232: Camera, Projector, 
Switch, Audio Mixer, Multimedia 
Device, etc.

Connects to

4 x RS-232 Ports

TTL Level (0 to 5 V)
Carrier Frequency: 

10kHz~455kHz

4 x IR Ports

or
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One IR Transmitter

Two IR Transmitters

IR Receiver

Unidirectional IR

2 x IR Transmitters

IR Receiver
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Digital I/O
These four channels can be used to connect Digital Input or Digital Output 
hardware devices such as switches, sensors, LEDs and relays. Each channel 
can be configured as either an Input (VDC), Input (Dry Contact) or Output 
channel.

Digital Input (Dry Contact): 
Digital inputs are hardware devices (switches, sensors, monitors) with two 
circuit signals – open and closed. These two signals provide indicators from 
sensors or switches of an event. An event can be the on/off power, dry contact, 
sensor or switch status from a device. This information is used to trigger events 
and functions through the VK2100. 

Digital Input (VDC):
Digital input 12VDC hardware devices (temperature, current and monitor 
sensors) provide voltage signals between 1 and 24. A digital input port detects 
if a voltage is above/below a specific threshold (1 to 24). If the voltage 
coming from a hardware device is higher than the set value, the VK2100 will 
detect the digital input as high. If the voltage coming from a hardware device 

Digital Input: Switches, Sensors 
Monitors and Button Triggers.

Digital Output: Switch, Screen, 
Projector Lift, Lighting and 
Equipment Control.

Connects to

4 x Programmable Digital
I/O Channels

Digital Input 
VDC Mode: 

-Input Voltage Range: 0 to 24 VDC
-Programmable Range: 1 to 24 VDC

Dry Contact Mode:
 -Pull-up 2k ohms to + 12 VDC

Digital Output:
 250 mA sink from 12 VDC
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is lower than the set value, the VK2100 will detect the digital input as low. 
This information is used to trigger events and functions through the VK2100. 

Digital Output: 
Digital output channels provide non-powered dry contact (open and closed) 
circuit control of hardware devices such as electric screens, projector lifts and 
other motorized equipment. 
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RS-232
These two bi-directional RS-232 ports provide serial control of hardware 
devices (projectors, matrix switches, etc.) and receive status messages from the 
connected devices. For bi-directional RS-232 control, the transmit, receive and 
ground pins must be wired on both the VK2100 and hardware device. Each 
hardware device requires different wiring. Please consult each hardware 
device's manual for details.

Projector, Matrix Switch, 
Camera, etc.

Baud Rate: 300 to 115200 
(default: 9600)

Data Bit: 8 (default) or 7

Stop Bit: 1 (default) or 2

Parity: None (default), even or 
odd

Connects to

2 x Bi-directional RS-232 Ports
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RS-232 / 422 / 485
These four bi-directional ports provide serial control of hardware devices 
(projectors, switches, etc.) with programmable pin assignments and receive 
status messages from the connected devices.

Pin Assignments

RS-232 RS-422 RS-485

Pin2: RX Pin1: RX- Pin3: D+

Pin3: TX Pin2: RX+ Pin4: D-

Pin5: GND Pin3: TX+

Pin7: RTS Pin4: TX-

Pin8: CTS Pin5: GND

Projector, Matrix Switch, 
Camera, etc.

Connects to

Configurable by pin assignment

Baud Rate: 300 to 115200 
(default: 9600)

Data Bit: 8 (default) or 7

Stop Bit: 1 (default) or 2

Parity: None (default), Even or 
Odd

Flow Control: None (default) or 
RTS/CTS

4 x Programmable 
Bi-directional RS-232/422/485 
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Chapter 3
Browser Operation

Overview

The VK2100 can be configured over a standard TCP/IP connection via its 
built-in Graphical User Interface (GUI). Because it can be accessed from 
anywhere over a network or the Internet, operators can easily log in via a web 
browser. The web interface can be used to upload licenses, set the access key, 
enable monitors and update the firmware. 

Logging In

To access the GUI, type the IP address of the controller into the address bar of 
any browser. If a Security Alert dialog box appears, accept the certificate – it 
can be trusted. The Welcome screen appears:

The default IP address is http://192.168.0.60 
The default password is: password
Enter the password, then click Login.
Only one user can log in at a time. 
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Dashboard

The Dashboard appears when you successfully log in to the VK2100. The 
Dashboard gives a quick view of each section’s settings. Click Manage to 
configure the settings any section. 

The top bar provides two options:

 Click to enter the Settings page. 

Click to Logout of the web session. 
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Settings

The Settings page provides five tabs to select from. Each tab provides options 
to configure the controller. The page is divided into two parts, the Interactive 
Display Panel which is used to configure the options and the Top Bar which 
provides icons to exit the settings page and log out of the web session. 

The Settings page opens on the General tab, as shown below:

The General tab provides settings and information about the VK2100, as 
described in the table below. 

Controller Info Provides network and identification information pertaining to the 
VK2100.

Controller ID: Displays the Controller ID # set on the rear of the 
VK2100.
IP Address: Provides the IP address of the VK2100. 
MAC Address: Provides the hardware MAC address of the 
VK2100. 

Date & Time Provides two options to set the date and time: 
Time Zone: To establish the time zone for the VK2100, use the 
drop-down menu and choose the city that most closely corre-
sponds to where it is located. 
Set Manually: Use the drop-down menus to manually set the 
Date (Year/Month/Day) and Time (Hour:Minute:Second). 
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Licenses
The Licenses tab allows you to upload and view license information. 

Firmware Displays the Current Firmware version and option to upgrade. 
Click Update Firmware to open the Firmware Upgrade window. 
Click Browse to select the firmware upgrade file.
When Check FW Version is selected, the system will check the 
current firmware version against the one being used to upgrade the 
VK2100. If the device version is higher than the upgrade version a 
dialog box informs you and gives you the option to continue or 
cancel.
After the file has been selected, click Update to start the firmware 
upgrade. 

Licenses This section shows information about the licenses that are available 
on the controller. A license is used each time an iPad connects to 
the VK2100 to control devices. In Use displays the number of 
licenses being used by iPads. Not in Use displays the number of 
licenses available for use. 
Total shows the number of licenses purchased for use on the 
VK2100. 

Add Clicking Add opens the Add License window to upload new 
licenses to the VK2100. Click Browse to locate the license file and 
Add to upload the license(s).
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Capacity
The Capacity tab displays information about the space available for storing 
viewer profiles on the controller.

Storage This section shows a graph displaying the percentage of space 
available on the controller to upload viewer profiles, as well as:

Space Used: The amount of space currently being used to store 
viewer profiles uploaded to the controller. 
Space Available: The amount of space currently available to 
store viewer profiles on the controller. 
Total Space: The total amount of space available to store viewer 
profiles on the controller. 

Existing Viewer This section lists all the viewer profiles that are currently stored on 
the controller with their name and assigned room. Click Remove to 
delete a single viewer profile or Remove All to delete all viewer 
profiles from the controller. 
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Access Key
The Access Key tab allows you to manage the password that is used to upload/
download viewer files to the controller and from the iPad.

Show on 
dashboard

Check this box to show the Access Key settings on the Dashboard.

Current Access 
Key

Enter the password required to upload/download viewer profiles so 
that you can create a new access key. 

New Access Key Enter the current password in the Current Access key box and then 
use the New Access Key box to enter a new password, finally use 
the Confirm Access Key box to re-enter the new password. 

Enable Viewer 
Access Key

Check this box to require a password when uploading/downloading 
viewer profiles to the controller and from the iPad. 

Save Click to save changes to the access key settings. 
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Monitor
The Monitor tab allows you to view and enable the monitors that have been 
configured for Flags and digital input devices in the VK6000 software. Check 
the Show on dashboard box to show the Monitor settings on the Dashboard. 
Click the slide bar next to the monitor you want to enable or use the drop-down 
menu to select All On or All Off.

For more information about creating monitors, see Advanced Editor, page 72. 
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Chapter 4
Software Installation

Overview

The ATEN Configurator software (VK6000) is a GUI-based management tool 
that helps you setup and configure the hardware and controls for the ATEN 
Control System App. To install the ATEN Configurator software, use the CD 
that was provided with your package and follow the instructions below. 

Configurator Software

Installation
To install the ATEN Configurator software, do the following:

1. Place the CD that came with your package into the CD-ROM drive on 
your computer. 

2. Double-click the ATEN Configurator.x.xxx.exe file to run the setup and the 
Choose Setup Language screen appears. Select the language and click 
Next.
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3. When the Welcome screen appears, click Next. 

4. The License Agreement appears:

If you agree with the License Agreement, select I accept the terms of 
the license agreement, and click Next. 

Click Print to print the Software End User License Agreement. 
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5. The Choose Destination Location screen appears:

Click Change to choose a location where you would like to install the 
program, or use the default location and click Next. 

6. The Ready to Install the Program screen appears: 

Click Install to begin the installation.
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7. The Setup Status screen appears with the progress bar:

8. When the process is done, the InstallShield Wizard Complete screen 
appears:

Click Finish.
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Chapter 5
ATEN Configurator (VK6000)

Overview

The ATEN Configurator software provides four easy steps to setup the 
hardware and create an interface with controls for each device. After you 
connect hardware to the VK2100, use the software to start a project to 
configure each of the controller ports, then design a user interface for the iPad 
and finally upload the information to the controller (VK2100).

Preface

The ATEN Configurator software guides you through setup in four easy steps. 
Use Project Information to enter details about the project; Select Device & 
Configuration to configure controller ports according to the connected 
hardware; Create Viewer & Design to design a user interface and configure 
the buttons that control each device; and Search & Upload to upload the 
project to the VK2100 controller. 

The Project Bar in the ATEN Configurator software provides a link to each of 
the four steps that are discussed in this chapter. 

Project Information, page 44
Select Device & Configuration, page 45
Create Viewer & Design, page 51
Search & Upload, page 82
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Main Page

Double-click the Configurator.exe shortcut to open the ATEN Configurator 
software. The Project Information page appears:

Note: To install the ATEN Configurator software, see Software Installation, 
page 33.

1 Menu bar The Menu Bar contains categories with options that 
pertain to different sections of the software. Menu bar 
items are listed on page 39. 

2 Project Bar The Project Bar contains four tabs. Each tab relates 
to a step required to setup the VK2100. Each step 
can be selected by clicking on the bar. Each step is 
discussed, starting on page 44.

3 Interactive Display Panel This is the main work area. The page that appears 
here reflects the project tab that is selected. 

4 Simulator The simulator button is used to test a viewer’s 
interface after it has been created in Create Viewer & 
Design. The simulator allows you to tryout the 
interface as it would work on the iPad but without 
actually controlling devices. Use the mouse to click 
through the page links. 
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Menu Bar

Use the Menu Bar to select options in each project tab. The table below 
provides a description of each menu item. 

Menu Sub-Menu Description

File New Project Select to create a new project. 

Open Project Select to browse and open a previously saved 
project. 

Close Closes the current project and returns to the 
Project Information tab. 

Save Select to save changes to the current project. 

Save as Use this option to save the project as a 
different name.

Export Viewer to USB Exports the viewer(s) and access key to a 
USB drive. After exporting the data onto the 
USB drive, plug it into the controller’s USB 
port to upload the viewer files and access key. 
These files can only be read by the controller 
and are not project files that can be opened 
by the ATEN Configurator software.

Project Report Click to save a PDF file that contains detailed 
information about each part of the current 
project.

Exit Select to close the project and exit.
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Edit Undo Select to undo a change when editing a 
viewer page in Create & Design Viewer.

Redo Select to redo a change when editing a 
viewer page in Create & Design Viewer.

Cut/Copy/Paste Select to cut, copy or paste text and objects 
when editing a viewer page in Create & 
Design Viewer. When used to copy and paste 
a button, both the General and Action 
properties are copied (see page 58). 

Paste Graphic Only Select to paste a button’s image but not its 
Action properties in Create & Design Viewer.

Delete Select to delete highlighted text and images 
when editing a page in Create & Design 
Viewer.

Delete Action Only Select to delete the Action properties of a 
button in Create & Design Viewer.

Select All / Deselect All Use either option to select or deselect all 
objects when editing a viewer page in Create 
& Design Viewer.

Preferences Display 
Language

Use to select the language for the interface.

SSH 
Destination

Click to choose the location of the executable 
for the SSH Client software. To execute the 
program, go to the menu bar and select Tools 
→ SSH Client.

Interface Check a box to enable the feature described 
below:

Show Welcome Page: displays the Wel-
come screen when the ATEN Configurator 
software opens. 
Show Upload Tip Screen: displays a 
screen reminding you to set the controller 
ID before uploading profiles in Search & 
Upload. 
Auto Page Creation: automatically creates 
a viewer page in Create Viewer & Design, 
for every hardware device that is config-
ured in Select Device & Configuration.
Show Password: displays the characters 
entered for the password in Edit Access 
Key from Search & Upload.

Menu Sub-Menu Description
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View These options are available from Create Viewer & Design → Edit Viewer.

Zoom Zooms the viewer page to 25%, 50%, 75%, 
100%, 200% or Fit in Window. 
Note: A mouse wheel can be used to zoom 
the viewer page in or out. 

Project Information Select to go to Project Information.

Device Configuration Select to go to Select Device & Configuration.

Viewer Design Select to go to Create Viewer & Design. 

Project Upload Select to go to Search & Upload. 

Properties Select to show/hide the Properties window 
when editing a viewer page.

Align to Grid Select to automatically align objects with the 
grid. This places objects in perfect alignment 
with the grid dots when they are moved. Use 
Show Grid to display the grid dots. When 
Align to Grid is not selected, objects can be 
placed anywhere on the page.

Show Grid Select to display the grid dots on the page. 
Use with the Align to Grid option to set objects 
in perfect alignment on the page. 

Menu Sub-Menu Description
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Object These options are available from Create Viewer & Design → Edit Viewer.

Button Select to add a button to the viewer page. 

Text Select to add a text box to the viewer page.

Image Select to add an image to the viewer page. 

Scroll View Select to add a scroll box to the viewer page, 
then double-click it to add buttons. Use the 
box as a scroll window to easily access a list 
of buttons on the page. 

Group Group Select multiple objects and use Group to lock 
them together. Objects in the group will move 
together as one.

Ungroup Select grouped objects and use Ungroup to 
unlock objects from the group.

Order Bring to 
Front

Moves an object to the top position when 
objects are layered.

Send to 
Back

Moves an object to the bottom position when 
objects are layered. 

Bring 
Forward

Moves an object up one position when 
objects are layered. 

Send 
Backward

Moves an object down one position when 
objects are layered. 

Align Left Aligns two or more selected objects to the Left 
side of the object that is selected last. 

Center Aligns two or more selected objects to the 
horizontal position of the object that is 
selected last. 

Right Aligns two or more selected objects to the 
Right side of the object that is selected last. 

Top Aligns two or more selected objects to the Top 
side of the object that is selected last. 

Middle Aligns two or more selected objects to the 
vertical position of the object that is selected 
last. 

Bottom Aligns two or more selected objects to the 
Bottom side of the object that is selected last. 

Menu Sub-Menu Description



Chapter 5. ATEN Configurator (VK6000)

43

Tools Database Generator Opens the ATEN Database Generator which 
is used to manually add and configure 
hardware devices. This is where you can 
create custom devices to add to My Device 
Library. See ATEN Database Generator, 
page 85, for details.

Simulator The simulator is used to test a viewer’s 
interface after it has been created in Create 
Viewer & Design. The simulator allows you to 
tryout the interface as it would work on the 
iPad but without actually controlling devices. 
Use the mouse to click through the page 
links.

SSH Client This runs the SSH Client software selected 
under Edit → Preferences → SSH 
Destination. The SSH Client is used to 
communicate with the controller. 

Windows New Page Click to create a new viewer page or select a 
page to open in Create Viewer & Design.

Help About Provides the firmware version and support 
information for the Configurator software. 

Menu Sub-Menu Description
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Project Information

The Project Information tab allows you to enter details about the installation to 
start the project. Enter the information using the table below as a guide.

Project Name Enter the name of the project you are setting up. You can create 
multiple projects but for most installations only one project is 
required. 

Controller ID Displays the Controller ID for the controller in the project. Use the 
Controller ID in the project to set the Controller ID Switch on the 
rear of the VK2100.This tells the software which VK2100 to upload 
the device configuration and viewer profile information to.

ATEN Controller 
Type

Select the controller model you are installing. 

Number of Rooms Enter the number of rooms the VK2100 will control. When a viewer 
profile is created in Create Viewer & Design, you need to select the 
Accessible Room which will associate the profile to a controller via 
the room number. This link allows the software to know which 
controller to upload the viewer profile to.

Name Enter the client name associated with the project.
Address Enter the client address associated with the project. 
Phone Enter the client phone number associated with the project. 
Add Controller Click to add controllers* to the project. The number of controllers 

added should equal the number of VK2100 units being installed. A 
project can have up to 16 controllers.
*A controller is the software’s link to the VK2100 being installed.

Remove Controller Click to delete a controller from the project.
Start Project Click to begin configuring hardware devices. The Select Device & 

Configuration tab will open. 
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Select Device & Configuration

The Select Device & Configuration tab is used to configure VK2100 ports 
according to the connected hardware device. To add a device, select a port 
under Device Configuration and use the Device Library on the right sidebar 
to find the hardware. If a device is not in the Device Library, use the Database 
Generator to create a custom device (see page 85).

Device Configuration This section lists the ports on the rear of the VK2100. Select a 
Controller or Room in the left sidebar to display the ports. Each 
port needs to be configured according to the hardware device 
connected to it (see page 46).

Left Sidebar This section lists the Controllers and Rooms. Use the sidebar to 
add Controllers or Rooms to a controller. When a port is 
configured with a device, the device appears listed below the 
room on the sidebar ((see page 49).

Right Sidebar This section provides the Device Library option which contains a 
database of hardware devices that is used to configure VK2100 
ports.

Device Library The Device Library is an extensive database of hardware devices 
that is used to configure VK2100 ports (see page 50).

Properties This section displays information about the selected controller, 
port or room (see page 47). 
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Device Configuration
The Device Configuration page lists the VK2100 ports by type. Click a port to 
view its Properties (page 47). Double-click a port to open the Device Library 
and search for the hardware device to configure the port. Configure each port 
according to the hardware device connected to it.

Type Lists the VK2100’s port type and number.
Device Lists the device name entered in the Properties. 
Mode Lists the port’s communication mode. Click an arrow to select 

options:
Serial: RS232, RS422, or RS485
I/O: Input (VDC), Input (Dry Contact) or Output
IR: IR or RS232

Room Lists the room selected for a device. The rooms available depend 
on the number of rooms added to the controller. No drop-down 
menu appears if there is only one room. Each controller must have 
at least one room. Select the room where the device is installed. 

+ Add More 
Devices

RS422, RS485, LAN and IR ports can cascade additional devices 
that are connected to the first unit. IR ports can cascade 1 device, 
RS422 and RS485 ports can cascade up to 3 devices and LAN 
ports can cascade up to 19 devices.
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Properties
The Properties displays information about the selected device. The 
information available depends on the device or port selected. The table below 
describes information shown for all types, followed by sections for types that 
include additional options. 

Serial
Provides drop-down menus to configure the Baud Rate, Databit, Stopbit, 
Parity and Flow Control settings. Configure these options to match the serial 
device settings. End Character: enter characters in a telnet return message to 
mark the spot where the message should stop. Words before the End Characters 
will be included and words after it will be cut off in the return message. 

Name Displays the device name and allows you to edit it. 
Device Type Displays the device of the selected device.
Brand Displays the brand of the selected device. 
Model Displays the model of the selected device.
Version Shows the firmware version selected for the device. Use the drop-

down menu to select a different firmware version. Click the menu 
box next to the version number to open a PDF with the version 
history. The version history and different versions for a device can 
be manually added/updated via the Database Generator (see step 
3 of Edit / Add New Device, page 89).

Add Custom Enter a name for the device and click Add Custom to reserve a 
port for a new custom device. 

Arrow Bar Use the arrow bar at the top of the frame to open and close the 
properties window. 
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I/O 
Two drop-down menus appear for Input (VDC) ports: Lower Threshold and 
Upper Threshold. Set the thresholds according to the hardware device you are 
connecting and then configure a Monitor (see page 76).

Ethernet 
These options allow you to configure the settings for a PJLINK or TELNET 
LAN device. End Character: enter characters in a telnet return message to 
mark the spot where the message should stop. Words before the End Characters 
will be included and words after it will be cut off in the return message. 

Use the Protocol Type drop-down menu to select:
TELNET – allows control of a LAN device via telnet commands. Enter 
the IP Address, Port, Username and Password of the telnet controlled 
LAN device. 
PJLINK – allows control of data projectors over a network using the 
PJLink protocol. Enter the IP address, Port and Password of the LAN 
projector or device used to control the projector. 

VK2100
When you select a VK2100 controller from the left side bar, the properties 
provides a drop-down menu to set the Controller ID. See Controller ID, 
page 44, for details. 
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Left Sidebar
Controller
The Left Sidebar provides a tree view of the 
controllers and rooms. Each controller represents a 
VK2100 with the room(s) it manages. Selecting a 
controller allows you to configure its ports. When a 
port is configured for a device, it appears listed under 
the Room. 

Each controller must have one room. When installing 
multiple controllers in one room, add a room with the 
same name to each controller. 

Each controller name ends with an ID number: 
VK2100-ID01. Use this number to set the Controller 
ID Switch on the rear of the VK2100. This links the 
controller in the software to the VK2100 being 
installed.

Right click a controller to Add Room or Delete 
Controller.

Room
Rooms are associated with a controller and a viewer 
profile so that the information is uploaded to the 
correct VK2100 to control devices. 

Right click a room to Delete or Rename the room.

Use the buttons at the bottom of the sidebar to Add 
Controller or Add Room. 

Right Sidebar
The Right Sidebar provides the Device Library. Use the Device 
Library to configure a VK2100 port according to the hardware 
device connected to it. The Device Library provides an extensive 
database of hardware devices that can be double-clicked or drag 
and dropped into the Device Configuration page to configure the 
VK2100 ports. The Device Library is discussed on the next page.
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Device Library
The Device Library is a database of hardware devices that instantly configure 
VK2100 ports. Search the library for the device connected to a VK2100 port 
then add it to configure the port. For devices not in the library, use the ATEN 
Database Generator to create custom hardware (see page 85). 

Click Device Library on the right sidebar or double-click a port from the 
Device Configuration page to open the device library. 

Add a device by clicking +, Add to Project or by drag & drop. 

To search for a device type keywords into the box and click .
Click tabs to filter by All, Serial, I/O, IR, Relay or Ethernet.
Click headings to sort by Brand, Device Type, Model or Version.
Use the drop-down menu to select:

ATEN Device Library – ATEN’s database of hardware devices. 
My Device Library – Devices added in the Database Generator.
Create Device – Opens the Database Generator to create custom 
hardware devices for My Device Library (page 85).



Chapter 5. ATEN Configurator (VK6000)

51

Create Viewer & Design

The Create Viewer & Design tab is for creating the Viewer – the user interface 
that controls the devices from an iPad. Create a viewer for each room that has 
hardware devices connected to a VK2100. 

Viewer Settings The Viewer Settings page appears if no viewer has been created 
so that you can set the Viewer Properties. The viewer properties 
must be set before you begin configuring the viewer’s pages. When 
you are finished, click Done to begin designing the viewer pages. 
See Select Viewer, page 52, for details.

Left Sidebar The left sidebar lists each viewer and its pages.The sidebar allows 
you to add viewers and pages. These options become available 
after clicking Done on the Viewer Settings page. See Left Sidebar, 
page 49, for details.

Right Sidebar The right sidebar provides the Graphic Library (page 70) and 
Advanced Editor (page 72) options. See Right Sidebar, page 53, 
for details.

Viewer Properties The Viewer Properties section allows you to set the basic settings 
for the viewer. See Select Viewer, page 52, for details.
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Select Viewer
The Select Viewer page sets the basic properties for each viewer that you 
create. The viewer is a user interface designed for the iPad, with the pages and 
buttons to control each hardware device. Use the table below to select the 
viewer settings, then click Done to continue. 

Viewer Properties Displays the base settings that must be selected to create a viewer 
profile. 

Accessible Room Select the room that the viewer will control devices in. The viewer 
will only upload to a controller configured with the same Room 
name (see Left Sidebar, page 49). 
Select All Rooms to allow the viewer to control all rooms. Selecting 
All Rooms will upload the viewer profile to all controllers. 
The Accessible Room defines what Devices are available to 
configure new Actions in Button Properties (see page 59). Only 
Devices listed under the same Room (see page 49) as the viewer’s 
Accessible Room, will be listed for use in Button Properties. 

Home Page Sets the layout for the Viewer’s home page:
Blank: Creates a custom home page that you design from 
scratch.
ATEN Theme: Creates a home page with graphics. This theme 
provides a template that can be customized into your own home 
page design.

Done Click Done to edit the Viewer pages.
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Left Sidebar
Viewer

The Left Sidebar provides a tree view of the Viewers 
and Pages. Clicking a viewer opens the Page 
Overview which is a layout of the viewer’s pages. 

Right click a viewer to Delete, Rename or Edit the 
viewer. 

Use Add Viewer at the bottom of the sidebar to create 
a new viewer. 

Pages

Each viewer lists the Home Page, Link Page and a 
Device Page for each device added from the Device 
Library.

Clicking a Home Page, Link Page or Device Page on 
the sidebar opens a new tab where the page can be 
edited.

Right click a page to Delete or Rename the page. The 
Home Page cannot be deleted.

Use Add Page at the bottom of the sidebar to add a 
page to the viewer. 

Right Sidebar
The Right Sidebar provides the Graphic Library and Advanced 
Editor options. The Graphic Library provides ready-to-use 
objects for designing viewer pages. The Advanced Editor 
provides Macro, Monitor and Flag options to configure the 
function of buttons. The Graphic Library is discussed on page 70 
and the Advanced Editor on page 72.
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Page Overview
Page Overview shows each viewer page that controls the hardware devices 
from an iPad. Hardware devices added from the ATEN Library will have 
control pages automatically created for them. Custom hardware that is created 
with the Database Generator will appear with default buttons generated 
according to the Category selected (page 89). Actions added manually to the 
Functions List need to have a button added manually. 

Edit and add pages to design the layout for use on an iPad. Pages can be fully 
customized and designed with macros and buttons from different hardware 
devices and with any object, background, size, shape and color of your choice.

Page Overview Shows the Home Page, Link Page and a Control Page for each 
hardware device added from the Device Library.

Edit Click to customize a viewer page (see page 55). 
X Click the X located at the top right corner of the viewer page to 

delete it. 
Add Page Click to add a new page to the viewer.
Add Viewer Click Add Viewer to create a new viewer.
Sidebar Click a sidebar item to edit the viewer properties or a viewer page. 
Edit Preferences Click to return to the Select viewer page.
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Edit
Use Edit to customize the layout and design of a page. You can add custom 
buttons, labels, images, scroll view windows and backgrounds to the page. 
Buttons can be made into a Link, Macro or Function (page 58). On the 
sidebar, use the Graphic Library (page 70) to add objects and Advanced Editor 
(page 72) to configure advanced button actions. Objects can be layered, images 
can be imported and labels can be applied anywhere. 

Selecting an object opens the Properties at the bottom of the page.
Right click on the page to add a Button, Label, Image or Scroll View.
Drag and drop objects anywhere on the page. 
Right click on an object to select options.
Click the mouse wheel to zoom the page in or out.
Double-click on the page or an object to open the Graphic Library.
Use the Object menu options to Group, Order or Align objects.
Use the View menu options to select Show Grid and Align to Grid to set 
objects in perfect alignment. 
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Page Objects
To help identify objects, a number appears at the top right corner. The numbers 
are assigned in sequence, in the order that the object is added. These numbers 
help identify labels when configuring a Change Label (page 67) or a button 
when configuring a Change Button State (page 66). 

Each button has a symbol in the top left corner to indicate: 
“A” the button’s actions are configured correctly. 
“!” the button’s actions need to be modified or they will not work. 
A button without a symbol indicates that functions have not been added to 
it. For details on adding actions, see Action, page 59. 
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Properties
There are four types of properties that appear for different objects: 

Page Properties

The Page properties provides options to change the background of the page. 
Behavior – click the box to import an image (*.png,*.jpg*.jpeg*.bmp) to 
use as the background for the page. 
Position and Size – displays the Width and Length of the page according 
to the Resolution set in the Viewer Properties.

Label Properties

The Label properties provide options to change the text and formatting of a 
label. 

Name – type the text you want to use for the label (or slow double-click 
the label on the Edit page to edit the text). 
Font – use the drop-down menu to select the font type. 
Size – enter a number (1-200) to set the size of the text.
Alignment – aligns the text Right, Center or Left; and Top, Middle or 
Bottom within the label box.
Style & Color – formats text to Bold, Italic or Underline for the label. Use 
the drop-down menu to change the color of the text.
Position and Size – X and Y position the label at the coordinates entered. 
Width and Height set the size of the label. 
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Button Properties

The Button properties provide options under General and Action to configure 
the look and function of a button. A button can control a device, link to another 
page or run a macro. 

General
Mode – use the drop-down menu to select the button type: Normal for a 
button that stays the same when pressed or Toggle for a button that 
switches between two images to indicate the status. Use the Behavior 
option to set the images. When Toggle is selected you must add a Change 
Button State action to the command list (see Action settings, page 66). 
Name – (optional) type the text you want to use for the button (or slow 
double-click the button on the Edit page to edit the text).
Font – use the drop-down menu to select the font type. 
Size – enter a number (1-200) to set the size of the text for the button.
Alignment – aligns the text Right, Center or Left; and Top, Middle or 
Bottom within the button box.
Style & Color – formats text to Bold, Italic or Underline for the button. 
Use the drop-down menu to change the color of the text.
Behavior – click Normal to import an image to use as the button’s 
standard background and click Pressed to import an image to use when the 
button is pressed.
Transparency – enter a number (0-100) or use the slider-bar to set the 
transparency of the button.
Position and Size – X and Y position the button at the coordinates entered. 
Width and Height set the size of the button box. 
Reset Image Size – resets the button size. 

(Continues on next page.)
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Action

The Action section of the Button Properties is used to set what a button does 
when pressed. Use the table below for an overview and the instructions on the 
next page to add Actions and Advanced Options. 

Device Lists the devices and other options that can be selected to add 
actions to the Button properties. When a device or option is 
selected, actions appear in the Function list. The upper box lists the 
hardware devices and VK2100; the lower box lists Advanced 
Options. 

Function Lists the actions that can be added to the Command List. When a 
Device is selected the actions listed here can be added to the 
Command List to configure the button.

Command List Lists the actions that will initiate when the button is pressed. Device 
and Advanced Option actions can be added and associated in the 
command list together. Actions initiate in the order that they’re 
added.

Toggle ON / 
Toggle OFF

When the Button Mode (page 58) is set to Toggle, the Command 
List splits in two and you can set the toggle actions:
Toggle ON – lists the actions that initiate when the button is first 
pressed. 
Toggle OFF – lists the actions that initiate when the button is 
pressed a second time. When the button is pressed again, the 
Toggle ON action initiates and the cycle repeats. 
Use Move up to move an action up in the command list, or Move 
down to move an action down in the command list. 

Use Delete to remove an action from the command list. 

Use Save as Macro to save the actions in the command list as a 
macro. 

Use Test Tool to connect to a controller and test the action(s) in the 
command list. 
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Adding Actions 

The Action section allows you to configure what a button does when pressed. 
You can configure a button for Device commands (On, Off, Stop, Play, etc.), 
as a Macro to send multiple commands to one or more devices, or as a Link to 
other viewer pages. Advanced Options allow you to add conditions to the 
actions, as described on the next page. 

To add an action to the button:

1. Select an option under Device.

2. Select an action from the Function list.

3. Double-click the action to add it to the Command list.

The actions that are listed under Function depend on the option selected in 
the Device list. 

4. Use the information below to understand how each Action section works 
and how to add Advanced Options to actions.
Device – lists hardware devices and options that can be selected to add 
actions. Select an option to add actions from the Function list. Only 
hardware devices with the same room as the viewer’s Accessible Room are 
listed. The Controller is listed first and allows you to add Special actions, 
as explained on the next page. In addition to device actions, you can add: 

Macro – sends multiple commands to one or more devices. Select to 
add a macro from the Function list. To create a macro, add multiple 
device actions to the Command list, then click the Save as Macro 

 icon or use the Advanced Editor (page 72).

Link – makes the button into a link that directs you to a viewer page. 
Select to add a page link from the Function list. Double-click the 
page link in the command list to select a different page link.
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Function – lists the actions that can be added to the Command list. Select 
an option under Device, then double-click or drag & drop actions in the 
Function list to add them to the Command list. 
Associate Set Flag, Condition, Change Button State, or Change Label 
options with actions in the Command list by dragging and dropping them 
into a tree view list, so that they initiate together (see Advanced Options, 
page 61).

If you select the Controller from the Device list, you can add the Special 
actions listed below. Double-click to add and double-click to configure: 

Delay – adds a delay in seconds. Enter a number between 0.1-180. 

Relay – adds an Open, Close, Toggle or Pulse action on the selected 
controller and Relay port. 

D/O – adds an Open, Close, Toggle or Pulse action on the selected 
controller and Digital Output port. 

Serial Raw (ASCII) – adds a serial command string that is entered 
for the port selected in ASCII mode. 

Serial Raw (HEX) – adds a serial command string that is entered for 
the port selected in HEX mode. 

Telnet Raw (ASCII) – adds a telnet command string that is entered 
for the device selected in ASCII mode. 

Advanced Options 
Advanced Options allow you to include conditions with an action. Associate 
Set Flag, Condition, Change Button State or Change Label functions with 
actions in the Command list by dragging and dropping them into a tree view 
listed with the action, so that they initiate together. 

Set Flag – add a Set Flag to change a Flag’s value when an action changes 
a device setting. This sets the Flag value to match the new device setting 
(e.g. ON or OFF). Always add a Set Flag to a Condition Flag, after the 
device action(s):
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To add a Set Flag:

1. Select Set Flag under Device.

2. Select the Flag from the Function list. 

3. Drag and drop the Flag from the Function list to add it to the end of the 
Condition Flag, in a tree view list:

4. Double-click Set Flag in the Command list to use the drop-down menus to 
set the Flag and Value. 

Condition – adds a condition that must be met before the actions listed 
with it can initiate. When the button is pressed, the Condition's set value 
must equal the Flag or Feedback value for the action(s) to initiate. There 
are two condition types: Flag and Feedback.

Flag – adds a condition based on a Flag’s value. “If Flag equals Value” 
is true, the condition is met and the actions listed with the Condition 
will initiate. Always add a Condition Flag at the top of the Command 
list, next drag and drop the device action(s) and a Set Flag at the end, in 
a tree view list:
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To add a Condition Flag: 

1. Click Condition under Device.

2. Select Flag from the Function list.

3. Double-click Flag to add the Condition Flag to the Command list.

4. Double-click the Condition Flag in the Command list to use the drop-
down menus to set the Flag and Value. 

5. Drag & drop Device actions from the Function list to add them to the 
Condition Flag, in a tree view list:

6. Add a Set Flag after the last device action in the Command list:
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Feedback – adds a condition based on the text from a serial/telnet 
device’s return message. Always add a Condition Feedback to a 
serial/telnet command, with action(s) added below the Condition 
Feedback, in a tree view list:

There are two Condition Feedback types:
Equals – when the text sent from a serial/telnet device’s return 
message matches part of the text entered for a Condition Feedback 
Equals, the actions listed below it will initiate.

To add a Condition Feedback Equals: 

1. Click Condition under Device.

2. Select Feedback from the Function list.

3. Drag and Drop Feedback from the Function list to add it to the Serial/
Telnet command, in a tree view list:

4. Double-click If Feedback equals to in the Command list and use the 
drop-down menu to select equal to and enter the Text. 

Text entered here must match part of the text from a serial/telnet 
device’s return message for the action(s) to initiate.
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5. Drag & drop device action(s) from the Function list to add them to the 
Feedback Equals Condition, in a tree view list:

Bypass – this option bypasses matching text from the serial/telnet 
return message and initiates a Change Label action. The label’s text 
will change to the return message sent from the device (i.e. the 
Feedback Result). A Change Label must be added to the Feedback 
Bypass for it to work.

To add a Feedback Bypass Condition with Change Label:

1. Click Condition under Device.

2. Select Feedback from the Function list.

3. Drag and Drop Feedback from the Function list to add it to the Serial/
Telnet command, in a tree view list:

4. Double-click If Feedback equals to in the Command list and use the 
drop-down menu to select bypass.



ATEN Control System User Manual

66

5. Select Change Label, under Device.

6. Select the Device Page where the label is located from the Function list.

7. Drag and drop the Device Page from the Function list to add it to the 
Feedback Bypass Condition, in a tree view list:

8. Double-click Change Label in the Command list to use the drop-down 
menu and select the label you want to use. Labels can be identified by the 
number located in the upper right-hand corner of the object. 

The label’s text will change to the Feedback Result from the serial/
telnet device’s return message. 

Change Button State – this option is used to change the button image 
when toggling between two actions – allowing the button image to switch 
depending on the status: Normal or Pressed. Always add a Change 
Button State at the end of the action(s) in the Toggle ON and Toggle OFF 
Command lists. 

To add a Change Button State:

1. Under General, set the Button Mode to Toggle. 

2. Under Behavior, select the Normal and Pressed button images. 
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3. Add Toggle ON and Toggle OFF actions to the Command lists.

4. Under Device, select Change Button State.

5. Select the Device in the Function list. 

6. Select the Toggle ON radio button, then double-click the Device in the 
Function list to add it to the end of the Toggle ON Command list. 

7. Select the Toggle OFF radio button, then double-click the Device in the 
Function list to add it to the end of the Toggle OFF actions in the 
command list.

8. Double-click the Change Button State in each Command list to set the 
Button and Status (Normal or Pressed). 

Change Label – this option changes a label’s text with the text that you 
enter manually or with the text from a serial/telnet device’s return message 
(i.e. the Feedback Result). A Change Label that uses a serial/telnet return 
message, must be added to a Feedback Bypass Condition (page 65). A 
Manual Change Label can be added at the beginning, end or with a 
Condition in the Command list. Adding it to a Condition guarantees the 
label will not change unless a condition is met and the action initiates. 



ATEN Control System User Manual

68

To add a Manual Change Label:

1. Click Change Label under Device.

2. Select the Device Page where the label is located from the Function list.

3. Double-click the Device Page to add the Change Label to the Command 
list; or drag and drop the Device Page to add the Change Label to a 
Condition in the Command list. 

4. Add a Change Label to multiple Command lists or Toggle ON and Toggle 
OFF Command lists to have the same label change text for different 
actions. 

5. Double-click Change Label in the Command list to use the drop-down 
menu to select a Label and input the Text. This is the text in the label that 
will appear when the button is pushed. 

Repeat the steps to add a Change Label for the reverse action (e.g. On 
or Off). 
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Image Properties

The Image properties provide options under General to change and import 
images to the page. Images can be layered with other objects so that they can 
be placed as a background or highlight for buttons (see image below). You can 
Group, Order and Align images from the Object menu. 

Behavior – shows the image selected. Click inside the box to import an 
image (*.png,*.jpg,*.jpeg,*.bmp) to the page.
Transparency – enter a number (0-100) or use the slider-bar to set the 
transparency of the image selected.
Position and Size – X and Y position the image at the coordinates entered. 
Width and Height set the size of the image. 
Reset Image Size – resets the image size. 
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Graphic Library
The Graphic Library on the sidebar provides ready-to-use objects for 
backgrounds, buttons, icons and device interfaces. Device Interface provides 
entire page layouts that you can use as templates for different types of devices. 
Double-click or drag and drop graphics to add them to the page. Images can be 
imported for icons and buttons in various formats (*.png,*.jpg,*.jpeg,*.bmp). 

Background

Button



Chapter 5. ATEN Configurator (VK6000)

71

Icon

Device Interface
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Advanced Editor
The Advanced Editor provides settings to create a Macro for buttons, a 
Monitor for events or a Flag to track settings. The table below gives a brief 
description of each section and the pages that follow provide instructions to 
create a macro and Monitor. 

Macro Macros initiate a sequence of actions on one or more hardware 
devices.

Monitor Monitors allow you to set Conditions for Digital Input (dry contact) 
and Digital Input (VDC) signals and Flags on a port that will initiate 
an Action.

Flag Flags are created to include parameters when settings are changed 
to indicate the current status.

+ New Opens a pop-up menu to create a Macro, Monitor or Flag.
Select Viewer Lists the viewers available to create a Macro or Monitor setting for. 

Click on a viewer to see the list of Preset macros or Preset Monitors 
that have been created.

Preset Macro / 
Monitor

When you click a viewer under Select Viewer – the macros or 
Monitors created for it will be listed here. Click on a Preset Macro or 
Monitor to configure its settings. 

Conditions This section is for Monitor settings only and is used to set the 
conditions for signals sent from Digital Input (dry contact), Digital 
Input (VDC) devices and Flags. 

Action This section is used to add actions to the Macro or Monitor. Actions 
added to the Action list will initiate when a custom button (Macro) is 
pressed or port signals (monitor) meet a set condition.
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Macro
Macros allow you to create a button that will initiate a sequence of actions 
across the same or different hardware devices. This saves time by allowing 
multiple devices to initiate actions all at once from one button. For example, 
you can create a macro to start a video presentation by adding functions to: dim 
lights, power on source, power on display, lower screen and play source. You 
can also add time delays between actions in a macro. 

To create a macro:

1. Select Macro and click + New. 

2. The New Macro pop-up menu appears:

Enter a Name and select a Viewer from the drop-down menu, then 
click OK. 

3. Select the viewer and click the macro name under Macro:
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4. Go to the Actions section at the bottom of the page to select hardware 
under Device and add the Function to the Action List:

5. First select the hardware device, Macro, Link, Set Flag or Condition under 
Devices. 

Note: For more information on Functions, see Action, page 59.
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6. In the Function list, double-click an action to add it to Action List.
If you select a VK2100 device, you can add and then configure these 
actions by double-clicking on them in the Action List: 

Delay – adds a delay in seconds. Enter a number between 0.1-180. 

Relay – adds an Open, Close, Toggle or Pulse action on the selected 
controller and Relay port. 

D/O – adds an Open, Close, Toggle or Pulse action on the selected 
controller and Digital Output port. 

Serial Raw (ASCII) – adds a serial command string that is entered 
for the port selected in ASCII mode. 

Serial Raw (HEX) – adds a serial command string that is entered for 
the port selected in HEX mode. 

Telnet Raw (ASCII) – adds a telnet command string that is entered 
for the port selected in ASCII mode. 

7. After adding all the functions to the Action List, the macro is complete.

8. In Create Viewer & Design, create a button and add a macro to the Button 
Properties from the Action tab by selecting Macro under Devices:
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Monitor
A Monitor allows you to set the conditions on a port for the signals from 
Digital Input (VDC) and Digital Input (Dry Contact) devices or Flags that 
will initiate an action. Digital Input (VDC) hardware devices provide voltage 
signals between 1 and 24. Digital Input (Dry Contact) are hardware devices 
with open and closed circuit signals. These signals provide indicators from 
sensors or switches of an event. An event can be the temperature, power, dry 
contact, sensor or switching status from a device. 

Create a monitor for a Digital Input port with a Condition that specifies an 
Action according to the signal sent from the device. 

To create a Monitor:

1. Select Monitor and click + New. 

2. The New Monitor menu appears:

Enter a Name and select the Viewer (associated with the room/
device you are configuring) from the drop-down menu, then click 
OK. 

3. Select the Viewer under Select Viewer and click the Monitor under Preset 
Monitor:
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4. Under Condition, use the drop-down menu to select the Operator:

Operator options are only for advanced setups that require multiple 
events from hardware devices connected to multiple D/I ports. Most 
devices only require one signal Status added to the Condition List to 
initiate an Action. Most installations will not need to use the 
Operator option, therefore it can be ignored. 

AND: Add multiple conditions from different D/I ports – all of 
which must be met for the Action to initiate. 

OR: Add multiple conditions from different D/I ports – one of which 
must be met for the Action to initiate. 

5. Under Select Devices, select the D/I port:

Note: The Viewer selected for the monitor must have a Digital Input 
(dry contract) or Digital Input (VDC) port or a Flag configured for 
devices to appear in the list.
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6. Under Select Status, add a status to the Condition List:

The High or Low status tells the Monitor to initiate an Action when the 
device signal is above or below the threshold setting* for the port:

Digital Input (VDC)

High - states that when the voltage signal is above the Upper 
Threshold to initiate the Action.
Low - states that when the voltage signal is below the Lower 
Threshold to initiate the Action.

Digital Input (Dry Contact)

According to an open or closed circuit status for the port: 

Open - states that when the circuit is Open to initiate the Action.
Closed - states that when the circuit is Closed to initiate the Action. 

Note: To configure the Upper and Lower threshold for the Digital Input port, 
see Properties, page 47.

7. (Optional) Use the Operator option to add additional High or Low 
conditions (see step 4, page 77). 

8. Go to the Actions section at the bottom of the page to select the hardware 
Device and add the Function to the Action List:

Note: For more information on Functions, see Action, page 59.
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9. First select the hardware under Devices. 

If you select a VK2100, you can add special actions and double-click 
on them in the Action List box to configure: 

Delay – adds a delay in seconds. Enter a number between 0.1-180. 

Relay – adds an Open, Close, Toggle or Pulse action on the selected 
controller and Relay port. 

D/O – adds an Open, Close, Toggle or Pulse action on the selected 
controller and Digital Output port. 

Serial Raw (ASCII) – adds a serial command string that is entered 
for the port selected in ASCII mode. 

Serial Raw (HEX) – adds a serial command string that is entered for 
the port selected in HEX mode. 

Telnet Raw (ASCII) – adds a telnet command string that is entered 
for the port selected in ASCII mode. 

10. From the Function list, double-click an action to add it to the Action List. 

This is the Action that initiates when the Condition is met. 

11. You can also add a Macro, Link, Set Flag or Condition.

12. After adding all the functions to the Action List, the monitor is complete. 
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Flag
Flags are created for control buttons to include parameters for when settings 
are changed or requests are made to change settings on a device. Flags indicate 
what the status is and what action to take according to the value. Flags are 
added as actions to Button Properties as a Condition or Set Flag value. 

Conditions tell a button to initiate associated actions if the flag value is true: “If 
Flag equals Value” initiate the action. Actions are associated with a condition 
so that they only initiate if the flag value is correct. That way an ON command 
is only sent to a device if the current flag value is OFF. 

Set Flag changes the flag value when a device setting has changed. So that if a 
device is OFF and the action turns the device ON, adding a “Set Flag 1 to ON” 
will change the flag value to ON. Now the flag’s value matches the device 
status so that actions associated with flag Conditions will initiate accordingly. 

Create flags for a device and add them as a Condition and Set Flag value in the 
Action – Button Properties (see Action, page 59). 

To create a Flag:

1. Select Flag and click + New. 

2. The New Flag menu appears:

Enter a Name and use a radio button to set the flag value: 

Select On/Off and use the drop-down menu to select the Default 
Value. 
Enter a range (1-100) for the values in the two boxes and use the 
drop-down menu to select the Default Value.
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3. Click OK to create more flags or Cancel when you are finished. The flags 
will appear in the list below.

Name – Lists the Flag names which have been created. 

Value – Lists the flag’s values or range of values. 

Default Value – Lists the flag’s default value.

Level – Lists the number of values available for the flag. 

4. Select Condition or Set Flag to add flags as Actions in the Button 
Properties of the device’s viewer page (see Action, page 59). 
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Search & Upload

The Search & Upload page lets you search for Controllers and upload the 
Viewers. Viewers created for each Controller will be listed below the 
Controller. The Accessible Room selected for a viewer determines which 
Controller it uploads to – based on both having the same room number. 

If Controllers can not be found, check the Controller ID Switch on the VK2100 
– it should match the ID # of the Controller (VK2100-ID01) in the ATEN 
Configurator software. 

Search Enter the IP address and click Search to locate a Controller.
Auto Search Click to locate Controllers without specifying an IP address.This 

option only searches for controllers on the same local area network. 
For controllers across a network device, such as a router or switch, 
you must specify the IP address. 

Edit Access Key Allows you to change the password required to upload viewers to 
the controller and download viewers from the iPad. 
These icons can be clicked to enable or disable the Access Key:
Locked: The Access Key is required to upload viewers to the 
controller and download viewers from the iPad.
Unlocked: The Access Key is not required to upload viewers to the 
controller and download viewers from the iPad.
Note: If you attempt to change the lock status and the Access Key 
has been changed from the Dashboard, a window will pop-up and 
you will need to enter the new Access Key.
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If the Access Key has been changed on the controller via the 
Dashboard, the lock icon will appear with an X, indicating you need 
to enter the new Access Key to change the Locked/Unlocked 
status. 
Click to view information about the Controller:

IP Address: Displays the controller’s IP address. 
MAC Address: Displays the controller’s MAC address.

License: Displays the number of licenses available and being 
used. 

Select License: Allows you to load a new license file.

Reset License: Resets all license(s) in use by iPads. This 
will disconnect all iPad connections to the controller(s).

Firmware Version: Displays the firmware version of the 
controller.

Select Firmware: Allows you to load a firmware upgrade file 
to update the controller’s firmware. 

Capacity: Displays the amount of space available on the control-
ler for uploading viewers.

Existing Viewers: Lists the viewers currently stored on the 
VK2100.

Remove Viewer: Click to remove the viewer stored on the 
controller. 

Upload to 
Controller

When Controllers are found, this option allows you to select the 
Controllers and viewers to upload. Once a selection is made, click 
Upload to Controller. 
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Chapter 6
ATEN Database Generator

Overview

The ATEN Database Generator lets you add, edit and manage hardware 
devices for My Device Library. To open the Database Generator from the 
ATEN Configurator, use the menu bar to select Tools → Database Generator. 
The first time the application is opened, a window appears with four options:

Add New Device Configure a custom hardware device to add to My Library. 
Add Device from 
ATEN Library

Add devices from the ATEN Device Library to My Library. 

Add Device from 
Others Library

Add devices from a database file (*.vkd) to My Library. 

Check Box Click Do not show this dialog again to prevent the dialog from 
appearing when the Database Generator is opened. Use the 
Preferences menu option to bring the dialog window back. 

Close Click the Close button to exit the dialog window. 
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My Library

My Library allows you to create a custom list of hardware devices which can 
be selected to configure ports on the VK2100. My Library lists all the 
hardware devices that you have created, added and edited using the Database 
Generator. You can create new hardware devices and/or add existing devices 
from the ATEN Library (page 95). These devices can then be selected from My 
Device Library (page 50) for use. 

Menu Description

File The File menu provides options to:
Add New Device: Configure a custom hardware device to add 
to Device Library.
Add Device from ATEN Library: Add devices from the ATEN 
Device Library to My Library.
Add Device from another Library: Add devices from a data-
base file (*.vkd) to My Library.
Export My Library: Saves My Library as a database file (*.vkd) 
that can be imported later.
Export Selected Device: Saves the selected device(s) as a 
database file (*.vkd) that can be imported later. 
Controller Connection: Searches for a controller to test the 
connection or run the learning mode for the IR port.
Quit: Exits the program. 
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Edit The Edit menu provides options to:
Delete: Deletes the selected devices from the database. 
Duplicate: Makes a copy of the selected device(s) and adds 
them to the library with the extension “-Copy”

Preferences: Provides options to:

Set the Language 

Show Add Device dialog on startup 

Show IR Learning tips

Set the IR Learning Timeout - how long to attempt a 
connection to an IR device before IR learning stops.

Library Provides a list of the Libraries that you can open to select devices 
from and edit or add to My Library. The libraries that are listed here 
appear when you select a database using Add Device from 
another Library.

Help The Help menu provides two options:
Update ATEN Library: Allows you to browse for a database file 
(*.vdk) to import devices into the ATEN library. 
About: Provides support and software version information. 

Menu Description
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Managing My Library 
When devices are added to My Library, they appear listed in the main window. 
New devices can be added by creating a new device, copying an existing device 
or by selecting a device from the ATEN Library. Use the check boxes to select 
individual devices or All to select the entire list.

Click to add a new custom device to the database.

Select a device and click this icon to create a duplicate.

Click to add and edit a device from the ATEN Library.

 Select a device and click Edit to change the settings.

 Select a device and click Delete to remove a device. 

 Key in word strings then click Search to find a device.

Click All, Serial, DO, IR, Relay or Ethernet to filter the list by type. 
Click Brand, Category, Model, Type or Version to sort the devices.
Click Export Selected Device to save the selected devices. 
Click Delete Selected Devices to remove the selected devices. 
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Edit / Add New Device
To edit or add a device to My Library, do the following:

1. From the menu select File → Add New Device, or select a device from My 
Library and click Edit.

2. Under General, use the drop-down menus or type in the Brand Name, 
Category, Model and Version. 
Note: The Category determines what buttons are auto generated when a 
viewer page is created for the device. 

3. Use the History button to open the Version History editor and make notes 
about the updates being made to the device configuration. You can create 
and use different versions of the same device and track the changes. The 
version history can be viewed and different versions selected from the 
ATEN Configurator, under device Properties (see page 47). 

4. Check the device type:

Serial

Settings – Use the drop-down menus to set the: Baud Rate, Data Bit, Stop 
Bit, Parity, Flow Control and Mode settings. 
Function List – Use this section to configure the device functions by 
adding actions to the list. Select the String Format: HEX or ASCII. 

 Click to add an Action. Double-click Name or String to edit. 
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Click to create a duplicate of the Action.

Click to add a drop menu into the String. 

Click to add an Enter command to the String.

Opens a menu with a list of commands to add to the String.

Click to delete the selected action. 

 After the string is configured, click Test to test the action. 
The serial device must be connected to Serial Port #6 (the very last 
serial port to right on the rear of the VK2100) to test the action with a 
device. 

IR

Settings – Use the drop-down menu to set the Repeat setting (number of 
times a signal is sent): 1 Time, 2 Times or 3 Times (Default). 
Function List – Use this section to configure the IR remote functions by 
adding actions to the list and using the learn feature. 

 Click to add an Action. 

 Click to create a duplicate of the Action
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Click to delete the selected action. 

 Click to auto run Learning Mode for all the IR actions 
in the Function List. When the Quick Mode window opens, click Start 
and follow the instructions on the next page. 

Click Learn to start Learning Mode (LED lights green). Point the IR 
remote at the IR Receiving port and push a button on the remote until 
the LED starts flashing green. When the learning is complete, the LED 
will stop flashing.

Click Test to connect to a VK2100 and test the IR action on the device. 
A pop-up window will appear to allow you to select the controller, 
following which the test will proceed. Check the hardware device to 
confirm that it responded appropriately. The IR device must be 
connected to IR Port #1 (the very first IR port on the bottom left side 
on the rear of the VK2100) to test the action with a device.

The Status column reports results of Learn and Test. Learn OK 
indicates learning Mode was successful and the IR action was saved. 

Double-click the Name to edit the Action’s name. 

Digital Output

Function List – Use this section to configure the device functions by 
adding actions to the list.

Double-click the Name to edit the Action’s name.

Click the Function drop-down menu to select the type: Open, Close 
and Toggle.
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 Click to add an Action. 

 Click to create a duplicate of the Action

Click to delete the selected Action. 

Relay

Function List – Use this section to configure the device functions by 
adding actions to the list. 

Double-click the Name to edit the Action’s name.

Click the Function drop-down menu to select the type: Open, Close 
and Toggle.

 Click to add an Action. 

 Click to create a duplicate of the Action.

Click to delete the selected Action. 

(Continues on next page.)



Chapter 6. ATEN Database Generator

93

Ethernet

Settings – Use the drop-down menus to select PJLINK or TELNET and 
enter the Port number. Enter the IP Address, Username (Telnet only) and 
Password if you wish to test actions after they have been added to the 
Function List.
Function List – Use this section to configure the device functions by 
adding actions to the list.

 Click to add an Action. Double-click Name or String to edit. 

Click to create a duplicate of the Action.

Click to add a drop menu into the String. 

Click to add an Enter command to the String.

Opens a menu with a list of commands to add to the String.

Click to delete the selected action. 

 After the string is configured click to test the action. The 
device must be connected to the LAN for the action test to work. 
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5. Click Save. 

6. The device will appear in My Library. 
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ATEN Library
The ATEN Library provides the complete list of hardware devices in the ATEN 
database. You can add any device in the ATEN Library to My Library. Once a 
device is added to My Library, the device settings can be edited as needed. 

Use the check boxes to select devices to add to My Library. Check All to 
select all devices in the list. 
Key in word strings then click Search to find a device.
Click All, Serial, DO, IR, Relay or Ethernet to filter the device list by 
type. 
Click Brand, Category, Model, Type or Version to sort the devices.
Click Add to My Library to add the selected devices to My Library. 
Click Cancel to return to My Library.



ATEN Control System User Manual

96

This Page Intentionally Left Blank



97

Chapter 7
ATEN Control System App

Overview

The ATEN Control System App is a free app for the iPad which can be 
downloaded from the Apple App Store. The app allows you to download the 
viewer profiles from a controller. These profiles provide the interface for 
remote control of hardware devices.

Installing the App

To install the ATEN Control System App on the iPad, do the following:

1. From the iPad, tap the App Store icon.

2. In the search box, type “aten control”.

3. Tap ATEN Control System, then download and install the app. 

4. The ATEN Control System icon will appear on the iPad.

5. Press the icon to open the app. 

Button Sounds
After you install the app, go to the iPad Settings and find the ATEN Control 
so that you can enable/disable the Button Sound setting. 
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ATEN Control System App

When you open the ATEN Control System app for the first time, the default 
Welcome screen appears:

Tap Demo to try the ATEN Control System app. Tap Auto Search Controller 
to find a controller and download viewer profiles (see Welcome, page 102). 

Note: The default Welcome screen only appears until a viewer profile is 
downloaded to the iPad. The default Welcome screen will only reappear if the 
app is reinstalled, which deletes all viewer profiles. 
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Demo

The Demo page provides a preview of the ATEN Control System app with two 
sample rooms. Tap either room to view the controls of different hardware 
devices. Tap Quit Demo at the top right corner to exit.

Tap Room-101 or Room-102 to select a viewer profile to demo.

Room-101

This demo shows a Conference call interface with controls for a Projector, 
Screen and Lighting. Tap any of the device icons to open the control page. 
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Control Pages

The images above show the main page and control pages for the Projector, 
Screen and Lights in Room-101. 

Room-102

This demo shows buttons for different applications which can be pressed to 
start a Video Call, Conference Call, Presentation, etc. Tap the icons at the 
bottom (Light, Player, Projector, etc.) to view control pages for the different 
devices. Tap the Key icon to return to the previous page.



Chapter 7. ATEN Control System App

101

Control Pages

The images above show control pages for the Light, Player and Projector in 
Room-102. Tap the Home icon in the lower left corner to return to the previous 
page. 
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Welcome

The Welcome screen is the home screen of the ATEN Control System app. It 
lists the viewer profiles and provides administrative options. Tap a viewer 
profile to open the controls for a room (see Create Viewer & Design, page 51), 
or use the administrative options listed below.

Icon Description

Edit Viewer Profile – This page provides options to add, update 
and remove viewer profiles. See page 103 for details.

Manage IP – This page provides options to configure network 
settings for controllers and LAN devices. See page 104 for details.

Set Password – This page provides options to set a password for 
access to the Welcome page when a viewer profile is in use. See 
page 106 for details.

Log Report – This page provides an error log to troubleshoot 
connectivity issues. See page 107 for details.

App Information – This page provides information about the 
ATEN Control System’s software version. See page 107 for details.
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Edit Viewer Profile
The Edit Viewer Profile page allows you to add, update and remove viewer 
profiles. To download viewer profiles, tap Add Viewer (see Set Password, 
page 106). 

Add Viewer Tap Add Viewer to download viewer profiles from the Download 
Viewer Profile page. See page 108 for details. 
Tap the Information icon to view the MAC Address, IP Address 
and Controller ID of the controller associated with the viewer 
profile.

Update Tap Update to connect to the controller and download an updated 
version of the viewer profile. After the update, the “Downloaded 
Successfully” prompt will appear

Remove Tap Remove to delete the viewer profile. A dialog box will appear to 
confirm deletion of the viewer profile. 
Tap Delete to remove the viewer profile*, or Cancel to cancel the 
deletion.
Note: Viewer profiles are only deleted on the iPad, and will still be 
available on the controller. 
Tap the Camera icon in the top left corner to change the 
background for the Welcome page. 
Select Default to use the default background. Tap Photos to select 
an image from the iPad to use as a background. 

Done Tap Done to return to the Welcome page. 
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Manage IP
The Manage IP page allows you to edit network settings for the controllers and 
LAN devices added in the Configurator software (see Device Library, 
page 50). 

Tap to expand controllers to view connected LAN devices.

Depending on the LAN device selected, different options are available to 
configure the network connection, including: IP Address, Port, Username and/
or Password. 

Tap on a device to open the settings page. Use Edit to change settings, Apply 
to save or OK to exit. 

Controller
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PJLink Projector 

Telnet 
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Set Password
The Set Password page sets a password to access the Welcome page from a 
viewer profile. This prevents unauthorized users from changing the app 
settings. Users will be prompted for a password before they exit viewer profiles 
to access the Welcome page. 

Check Enable Password Protect, enter a password in the box and tap Set. The 
Show Password option appears after you check Enable Password Protect, 
allowing you to display the characters typed in for the password. Tap Back to 
exit. 
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Log Report
The Log Report page lists information and errors about the app which can be 
used to troubleshoot connection issues. Tap and drag the list to scroll through 
the error log. Tap Clear to delete the log information. Tap Back to exit. 

App Version
The App Version page displays the ATEN Control System’s version.
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Download Viewer Profile

The Download Viewer Profile page allows you to search for controllers and 
download viewer profiles. This page is accessed from Welcome → Edit Viewer 
Profile → Add Viewer.

Search Box Tap to enter the IP address of a controller, then tap Search to find it. 
When controllers are found on the network, they are listed in the 
Add Viewer box.
A Search History drop-down menu will appear for previously 
searched IP addresses. 

Search Enter the IP address of a controller then click Search to find it. The 
controller must be powered on and connected to the network. 

Auto Search Auto Search allows you to search for controllers without specifying 
an IP address. The controller must be powered on and connected 
to the same local network. 

Add Viewer This panel lists the controllers that have been found on the network. 
Each controller lists viewer profiles that can be downloaded to the 
iPad. To upload viewer profiles to a controller, see Search & 
Upload, page 82.

Back Back returns you to the Welcome page.
Download After you select the viewer profiles you want to download, click 

Download to start the process.
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Downloading Profiles
When controllers are found, they appear in the Add Viewer panel. Check the 
boxes of the viewer profiles you would like to download, then tap Download. 

Add Viewer The main window lists the controllers that have been found on the 
network. Under each controller is a list of viewer profiles with a 
check box. 
Use the check boxes to select the viewer profiles you want to 
download, then click Download. If the Lock icon appears, you will 
be prompted to enter the access key. 
After viewer profiles download, the “Downloaded Successfully” 
prompt appears. Tap Done to return to the Welcome page where 
the viewer profiles will be listed. 
Note: After you download a viewer profile to the iPad, the default 
Welcome screen no longer appears. 
When the Lock icon appears, you need to enter the access key 
before downloading viewer profiles from the controller. To set the 
access key, see Edit Access Key, page 82. 

Tap the Information icon to view the IP Address, MAC Address 
and License information of the controller. The license information 
provides the total number of licenses available and the number in 
use. 
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 Appendix

Safety Instructions

General
Read all of these instructions. Save them for future reference.
Follow all warnings and instructions marked on the device.
This product is for indoor use only.
Do not place the device on any unstable surface (cart, stand, table, etc.). If 
the device falls, serious damage will result.
Do not use the device near water.
Do not place the device near, or over, radiators or heat registers.
The device cabinet is provided with slots and openings to allow for 
adequate ventilation. To ensure reliable operation, and to protect against 
overheating, these openings must never be blocked or covered.
The device should never be placed on a soft surface (bed, sofa, rug, etc.) as 
this will block its ventilation openings. Likewise, the device should not be 
placed in a built in enclosure unless adequate ventilation has been provided.
Never spill liquid of any kind on the device.
Unplug the device from the wall outlet before cleaning. Do not use liquid 
or aerosol cleaners. Use a damp cloth for cleaning.
The device should be operated from the type of power source indicated on 
the marking label. If you are not sure of the type of power available, 
consult your dealer or local power company.
The device is designed for IT power distribution systems with 230V 
phase-to-phase voltage.
To prevent damage to your installation it is important that all devices are 
properly grounded.
The device is equipped with a 3-wire grounding type plug. This is a safety 
feature. If you are unable to insert the plug into the outlet, contact your 
electrician to replace your obsolete outlet. Do not attempt to defeat the 
purpose of the grounding-type plug. Always follow your local/national 
wiring codes.
Do not allow anything to rest on the power cord or cables. Route the 
power cord and cables so that they cannot be stepped on or tripped over.
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If an extension cord is used with this device make sure that the total of the 
ampere ratings of all products used on this cord does not exceed the 
extension cord ampere rating. Make sure that the total of all products 
plugged into the wall outlet does not exceed 15 amperes.
To help protect your system from sudden, transient increases and 
decreases in electrical power, use a surge suppressor, line conditioner, or 
un-interruptible power supply (UPS).
Position system cables and power cables carefully; Be sure that nothing 
rests on any cables.
Never push objects of any kind into or through cabinet slots. They may 
touch dangerous voltage points or short out parts resulting in a risk of fire 
or electrical shock.
Do not attempt to service the device yourself. Refer all servicing to 
qualified service personnel.
If the following conditions occur, unplug the device from the wall outlet 
and bring it to qualified service personnel for repair.

The power cord or plug has become damaged or frayed.
Liquid has been spilled into the device.
The device has been exposed to rain or water.
The device has been dropped, or the cabinet has been damaged.
The device exhibits a distinct change in performance, indicating a need 
for service.
The device does not operate normally when the operating instructions 
are followed.

Only adjust those controls that are covered in the operating instructions. 
Improper adjustment of other controls may result in damage that will 
require extensive work by a qualified technician to repair.
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Rack Mounting
Before working on the rack, make sure that the stabilizers are secured to 
the rack, extended to the floor, and that the full weight of the rack rests on 
the floor. Install front and side stabilizers on a single rack or front 
stabilizers for joined multiple racks before working on the rack.
Always load the rack from the bottom up, and load the heaviest item in the 
rack first.
Make sure that the rack is level and stable before extending a device from 
the rack.
Use caution when pressing the device rail release latches and sliding a 
device into or out of a rack; the slide rails can pinch your fingers.
After a device is inserted into the rack, carefully extend the rail into a 
locking position, and then slide the device into the rack.
Do not overload the AC supply branch circuit that provides power to the 
rack. The total rack load should not exceed 80 percent of the branch circuit 
rating.
Make sure that all equipment used on the rack – including power strips and 
other electrical connectors – is properly grounded.
Ensure that proper airflow is provided to devices in the rack.
Ensure that the operating ambient temperature of the rack environment 
does not exceed the maximum ambient temperature specified for the 
equipment by the manufacturer.
Do not step on or stand on any device when servicing other devices in a 
rack.
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Technical Support
International

For online technical support – including troubleshooting, documentation, 
and software updates: http://eservice.aten.com
For telephone support, see Telephone Support, page iv:

North America

When you contact us, please have the following information ready beforehand:
Product model number, serial number, and date of purchase.
Your computer configuration, including operating system, revision level, 
expansion cards, and software.
Any error messages displayed at the time the error occurred.
The sequence of operations that led up to the error.
Any other information you feel may be of help.

Email Support support@aten-usa.com

Online 
Technical 
Support

Troubleshooting
Documentation
Software Updates

http://www.aten-usa.com/support

Telephone Support 1-888-999-ATEN ext 4988
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Specifications

Function VK2100

Hardware Connections 18

Interface Serial 4 x Programmable Bi-directional RS-232/422/
485 Ports (4 x DB9 Male Connectors, 

Configurable via Pin Assignments)

Baud Rate: 300 to 115200 (default: 9600)
Data Bit: 8 (default) or 7
Stop Bit: 1 (default) or 2

Parity: None (default), Even or Odd
Flow Control: None (default) RTS/CTS

2 x Bi-directional RS-232 Ports (2 x 3-Pole 
Terminal Block Connectors)

Baud Rate: 300 to 115200 (default: 9600)
Data Bit: 8 (default) or 7
Stop Bit: 1 (default) or 2

Parity: None (default), Even or Odd

IR/Serial 4 x Programmable IR / Uni-directional RS-232 
Ports (2 x 4-Pole Terminal Block Connectors)

IR: TTL level (0 to 5 V)
Carrier Frequency: 10KHz~455KHz

Serial: Uni-directional RS-232 ( + - 5 V)
Baud Rate: 300 to 115200 (default: 9600)

Data Bit: 8 (default) or 7
Stop Bit: 1 (default) or 2

Parity: None (default), Even or Odd

I/O 4 x Programmable Digital Input / Output 
Channels (1 x 5-Pole Terminal Block 

Connector)

Digital Output: 250 mA sink from 12 VDC

Digital Input:
VDC Mode 

Input Voltage Range: 0 to 24 VDC
Programmable Range: 1 to 24 VDC

Dry Contact Mode:
Pull-up 2k ohms to + 12 VDC

Relay 4 x Relay Channels (2 x 4-Pole Terminal Block 
Connector)

Normally Open, Isolated Relays
Contact Rating: Max 24 VDC, 2A

VDC 4 x 12 VDC Output Ports (2 x 4-Pole Terminal 
Block Connectors)

Power Supply: 12 VDC, 2A Max (Shared By 4 
Ports)

Connectors Ethernet 1 x RJ-45 Female, 10/100Base-T

USB 1 x USB Type A Female (White)

Power 1 x 3-prong AC power socket
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Switches Controller ID 1 x 16-Segment Switch

Power 1 x Rocker Switch

Reset 1 x Semi-recessed pushbutton

LEDs Relay 4 (Green)

IR / Serial 4 (Green)

I/O 4 (Green)

Serial RX 6 (Green)

TX 6 (Green)

Ethernet Link 1 (Green)

Act 1 (Green)

DC Output Overload 1 (Orange)

IR Learn 1 (Green)

USB 1 (Green / Orange)

Power 1 (Green)

IR Receiver 1 x IR Receiver Port

I/P Rating 100-240 VAC, 50-60 Hz

Power Consumption 40 Watt

Environment Operating Temp. 0–50ºC

Storage Temp. -20–60ºC

Humidity 0–80% RH, Non-condensing

Physical 
Properties

Housing Metal

Weight 2.64 kg

Dimensions (L x W x H) 43.72 x 16.32 x 4.40 cm

Function VK2100
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Limited Warranty

IN NO EVENT SHALL THE DIRECT VENDOR'S LIABILITY EXCEED THE PRICE PAID 
FOR THE PRODUCT FROM DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF THE PRODUCT, DISK, 
OR ITS DOCUMENTATION.

The direct vendor makes no warranty or representation, expressed, implied, or statutory with 
respect to the contents or use of this documentation, and especially disclaims its quality, 
performance, merchantability, or fitness for any particular purpose.

The direct vendor also reserves the right to revise or update the device or 
documentation without obligation to notify any individual or entity of such 
revisions, or update. For further inquiries, please contact your direct vendor.
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